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1 Introduction

I have worked extensively with a Tencor AlphaStep 200 profilometer during
my course of studies at Brigham Young University. My project reached a
point where I needed to store several consecutive profilometer scans to later
analyze. My first meager attempts at this resulted in writing down each value
on the profilometer screen by hand. This proved to be extremely tedious,
and thus began the quest to interface a computer with the profilometer. This
task was achieved through the work and help of Lynnell Wright and Brian
Phillips, who first discovered how to set the “print” mode on the profilometer
to correspond to a digital data transfer instead of a physical printout.

Many thanks must also be attributed to Matthew A. Hopcroft at the Uni-
versity of California, Berkeley, who provided a Matlab script that interprets
and plots profile data that has been captured by a hyperterminal program.
He also provided the insight into setting the jumper cable on the profilome-
ter CPU board so that digital data could be transferred via a serial cable.
He has provided a very robust program along with detailed instructions at
http://micromachine.stanford.edu/ hopcroft/Shared/profilometer.html.

Through the course of my research, however, I found that I was spending a
lot of time writing unique Matlab scripts for every set of data I was analyzing,
and my thoughts turned to creating a graphical method for allowing ease of
selecting and saving specific data points. This led to creating a graphical
user interface (GUI) in Matlab that allowed for high-level profilometer data
manipulation. This program is capable of reading in scanned data directly
from the profilometer without having to implement a separate hyperterminal
program. Data can also be read in from text files that have been previously
saved. Once the data is read in, it can be leveled, set to a zero point, and
reset. Altered profiles can then be saved out to a text file. This program
also allows directly saving the plot as an image with various options. This
program also allows a user to record several data points into one file to later
be plotted and analyzed. These capabilities are outlined in the table of
contents of this document, and will be explained in detail.

As of this writing, Profilometer GUI is still in its alpha stage (0.1), and
as such there undoubtedly will be errors or strange behavior beyond what I
have accounted for. In the case that you find any errors (lucky you), please,
to the best of your ability, outline the circumstances leading to the problem
and contact me at marknhamblin@gmail.com and I will attempt to address
the issue. Good luck with using the graphical interface, and I hope that it

http://micromachine.stanford.edu/~hopcroft/Shared/profilometer.html


2 GETTING STARTED 3

facilitates your research.

2 Getting started

The file profilometerGUI.m is a script file that must be run using Matlab.
This script was created using Matlab 7 (R14), so any version of Matlab that
is seven or higher should work. In order to run the program, simply double-
click the file name or open the file name inside of Matlab.

If the file loads successfully, you will see a screen that looks similar to
Figure 1. The numbers added to the screen indicate the main features of the
program:

1. File menu for scanning, loading, or saving data

2. Edit menu for leveling, zeroing, or reseting data

3. Analyze menu for concatenating data sets

4. Help menu for help document and information about the program

5. Screen where profile image will appear

6. Button to read in scanned data from the profilometer

7. Screen indicating current scan status

8. Button to level data on the screen

9. Button to set a zero point for data on the screen

10. Button to reset the data on the screen

11. Button to capture the selected data points on the screen and add them
to a running list

12. Displays the position of the left bar

13. Displays the profile height at the left bar

14. Displays the position of the right bar

15. Displays the profile height at the right bar
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16. Displays the spacing between the bars

17. Displays the height difference between the points at the bars

18. Check box that will cause the spacing between the bars to be locked

19. Displays the average height between the bars

20. Displays the deviation of height between the bars

21. Displays the surface roughness between the bars

Figure 1: Opening screen when profilometerGUI.m successfully loads.
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3 Reading-in profilometer data

Once a profile has been scanned by the profilometer, that data can then be
retrieved by the computer. While data can be sent from the profilometer,
unfortunately the profilometer cannot read incoming data. This means that
the serial port of the computer cannot instruct the profilometer to begin
sending data. There are three ways you can instruct the program to watch
for incoming profilometer data: 1. select Scan Data from the File drop-down
menu (number 1 in Figure 1), 2. press Ctrl + I, or 3. click on the Scan
button on the right side of the panel (number 6 in Figure 1).

Once the scan function has been called, the scan status field (number 7
in Figure 1 will change from idle (Figure 2(a)) to waiting (Figure 2(b)). The
status will remain at waiting until either data is sent from the profilometer
or the user clicks on the Scan button to return the scan status to idle. When
the program detects data being sent by the profilometer, the status field will
change from waiting to active (Figure 2(c)). At this point the Scan button
will become inactive until all data is successfully read in.

Figure 2: Values that the scan field can assume. (a) When status is set to idle,
the program is not checking for data from the profilometer. (b) When the status
is set to waiting, the program is actively watching for data to be sent to the serial
port from the profilometer. (c) When the status reads active, data is currently
being transferred.

To read in data from the profilometer, first the scan status must be set
to waiting. At this point, you must press the button labeled plot on the
profilometer. If this was successful, you will see a countdown of values on
the profilometer screen on the left side. Once all of the data is read in, the
scan field will automatically return to idle and the data will be plotted to
the screen. This is shown in Figure 3.
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Figure 3: Once data is retrieved from the profilometer through the serial port, the
resulting scan is plotted in the program window. The title [SCANNED DATA]
indicates that the current plot was scanned directly from the profilometer and has
not been saved.

4 Loading existing profilometer data

Once scanned data has been saved, it can be accessed by loading the ap-
propriate text file. Text files containing profilometer data can be loaded by
either selected Open File from the File drop-down menu (number 1 in Fig-
ure 1) or by pressing Ctrl + O. When Open File is selected, the menu in
Figure 4 will appear. Files can be selected by either clicking once on the file
name and then clicking on the load button, or by double-clicking the desired
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file name. It is possible to navigate through directories by double-clicking on
a selected folder or by double-clicking on .. to move up one directory.

Figure 4: Selecting Open File will cause this menu to appear. Folders are listed
on the left-hand side, while text files are listed on the right-hand side.

Once a file name has been activated, it will be plotted to the program
window, as shown in Figure 5.

5 Saving profilometer data

Once a profile is plotted on the program window, it can either be saved as
data in a text file or it can be saved as an image.
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Figure 5: A loaded file plotted in the program window. The title in this example,
05.txt, indicates that this is data that has been saved after being read in from the
profilometer or that it was loaded from an existing text file.

5.1 Saving data

To save a profile in the form of textual data, select Save and then Data from
the File drop-down menu. The shortcut key combination is Ctrl + S. If
there is no plot in the program window, nothing will happen. However, if a
plot exists, then the menu in Figure 6 will appear.

A file can be saved in a couple of ways. An existing file can be overwritten
by by first clicking on the existing file name and then clicking on save, or a file
can be overwritten by double-clicking on the desired file name. Otherwise,
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Figure 6: Selecting Save and Data will cause this menu to appear. Folders are
listed on the left-hand side, while text files are listed on the right-hand side. When
entering a file name, don’t include the extension.

a file name can be manually entered in the File Name field. Once this is
completed, a new text file will be created in the current directory with a .txt
extension appended to it. This file can later be loaded for further analysis.

5.2 Saving an image

To save a profile as an image, select Save and then Plot from the File drop-
down menu. The shortcut key combination is Ctrl + P. This will cause the
menu in Figure 7 to appear.

This menu allows you to see approximately what your image will look
like when it is created. As aspects such as font size, font type, units, and
image size are altered, they will be reflected in the small plot preview in the
upper-left quadrant of the window. This menu allows you to save your image
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Figure 7: Selecting Save and Plot will cause this menu to appear. Selectable image
characteristics include selecting the file type, resolution, image size, image units,
font type, font size, image title, and including statistical text applicable to the
plot.

as a raster (JPG, PNG, TIF), vector (EPS, PDF), or Matlab (FIG) image.
It will also allow you to specify the resolution (72, 150, 300, or 600), which
is specified in terms of points per inch. The size of the image can be set
using either points, inches, or centimeters. Only two font types are available,
Times New Roman or Arial, which allows you to specify a serif or a sans serif
font. The font size can range between 6 and 64. The figure title can be any
string you can contrive.

The statistics area of the menu allows you to check any of the listed
options you would like to appear in the saved image. Any of the checked
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options will appear along the right side of the image, and the values are
determined by the position of the left and right bars.

An example of a saved image using this menu is shown in Figure 8.

Figure 8: An image that was created using the Save Plot option. This image was
created to be 11 cm wide with a resolution of 300 points per inch, a font size of 10
points using an Arial font, and was generated as a PNG image.

6 Analyzing data

Once a profile has been plotted to the program window, you can query points
on the plot to produce useful information regarding your sample. To un-
derstand what information is available, refer to numbers 12 through 21 on
Figure 1.

Numbers 12 through 15 will display position and height data for the left
and right cursors. These cursors can be set by using the left mouse button
and right mouse button to produce left and right cursors, respectively. Left
click on any spot on the plot and the left cursor will be moved to that location.
Similarly, the right cursor will move to wherever a right click is made with
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the mouse on the plot. As these cursors are set, information regarding the
position of these cursors as well as the height of the data at those points will
appear in numbers 12 through 15. The position fields, numbers 12 and 14,
can also be manually entered by clicking on the field and typing in a number.

Fields 16 and 17 correspond to the change in position between the two
cursors (∆X) and the change in height between the points at those locations
(∆H). ∆H is perhaps the most commonly used measurement when dealing
with profilometry, since most user tend to want to know the step change from
one structure or film to another. An example of this is shown in Figure 9.
The value for ∆X can also be entered manually.

Next to the difference fields can be found the lock spacing check box,
which corresponds to number 18 in Figure 1. When this box is checked the
spacing between the left and right cursor is locked. You can at this point left
or right click on the figure to simultaneously move both cursors. If you click
so that one of the cursors would move off of the data range, it will stay at
the data’s furthest point. Then once you click anywhere back on the image
so that both cursors can fit in the range, the spacing between cursors will be
maintained at the original value at which they were locked. The lock spacing
can be overruled, however, if data is manually entered in either of the cursor
position fields or the ∆X field.

Fields 19 through 21 include statistical data such as the average height,
height deviation, and surface roughness, respectively. The average is com-
puted as the mean height between the two cursors, and the deviation is
computed as the standard deviation between those points as well. The sur-
face roughness is a measure of the roughness of the profile between the two
cursors. Figure 10 demonstrates the usefulness of statistical data.

7 Manipulating data

Once a profile has been plotted to the program window, it can be manipu-
lated using the Analyze drop-down menu or the buttons to the right of the
plot window (numbers 8 through 10 in Figure 1). These functions include
leveling the profiling data, creating a zero point for the data, and reseting
the displayed data.
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Figure 9: The usefulness of using the left and right cursors to measure the step
change from one feature to another. The left and right bars are shown placed on
the feature on the left of the plot. The displayed height different, ∆H, is 94.5 nm.

7.1 Leveling

Leveling is accomplished by shifting the data to result in the points at the
left and right cursors to be at the same value. First, you must place your
left and right cursors along the points that you would like to level to. There
are three ways of calling the leveling function: 1. select Level from the Edit
drop-down menu (number 2 in Figure 1), 2. press Ctrl + L, or 3. click
on the Level button on the right side of the panel (number 8 in Figure 1).
Figure 11 demonstrates the effect of leveling data.
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Figure 10: The left and right cursors are used over a somewhat flat segment of
this feature to highlight the height average, deviation, and the surface roughness.
In this case, the average is displayed as 89 nm with a deviation of 1 nm, and the
surface roughness is shown as 0.5 nm.

7.2 Zeroing

Zeroing is choosing a point on the plotted data to correspond to zero, and
the remaining data is shifted accordingly. This is useful when absolute values
need to be measured, for example, the average height of a particular feature.
This allows you to select a point to have a height of zero. The zero point is
determined by the position of the left cursor. There are three ways of calling
the zeroing function: 1. select Zero from the Edit drop-down menu (number
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Figure 11: Leveling data. (a) The data starts out slanted, so the left and right
cursors are placed to determine the leveling points. (b) Once the Level button is
clicked, the data shifts according to the left and right cursors and results in better
leveled data.
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2 in Figure 1), 2. press Ctrl + Z, or 3. click on the Reset button on the
right side of the panel (number 10 in Figure 1).

7.3 Reseting

Reseting is reloading the original data after performing functions such as
level or zero. This will discard any changes made to the data and re-plot the
original, while leaving the left and right cursors in their most recent position.
There are three ways of calling the reset function: 1. select Reset from the
Edit drop-down menu (number 2 in Figure 1), 2. press Ctrl + R, or 3. click
on the Zero button on the right side of the panel (number 9 in Figure 1).

8 Concatenating data

Data concatenation is a more advanced feature of this program, and will most
likely find application in only a few specific cases. The call to the concatenate
function can be done in one of three ways: 1. select Concatenate from the
Analyze drop-down menu (number 3 in Figure 1), 2. press Ctrl + A, or
3. click on the Concatenate button on the right side of the panel (number
11 in Figure 1). Once a profile is plotted in the program window and the
concatenate function is called, the menu in Figure 12 appears. The data
that is captured includes the following: the data set number (set), the left
cursor height measurement (Hl), the right cursor height measurement (Hr),
the height difference between the cursors (Hdiff), the average height between
the cursors (Havg), the deviation of the height between the cursors (Hdev),
and the surface roughness between the cursors (Ra). Also on this menu is
a field to enter a number for spacing between data sets (um):. This number
corresponds to the distance between the features that are being added to the
concatenate menu.

After the function has been called the first time, every other time it is
called the current data will be added to the existing data. The purpose of the
concatenate function is to allow you to string several consecutive profile scans
together into one cohesive image. For example, if you would like to profile
features over a length greater than the scope of the profilometer, you can
take multiple scans and then put them together using this function. When
multiple points are added to the set, it looks something like Figure 13. Once
all of the desired data is gathered, it can then be saved by clicking on the
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Figure 12: The concatenate data menu the first time it is called. It loads the
following values determined by the position of the left and right cursors: the data
set number (set), the left cursor height measurement (Hl), the right cursor height
measurement (Hr), the height difference between the cursors (Hdiff), the average
height between the cursors (Havg), the deviation of the height between the cursors
(Hdev), and the surface roughness between the cursors (Ra).

save button on the concatenation menu.
In order to view the results of the concatenated data, it is then necessary

to load it using the Open File function which can be found under the File
heading of the drop-down menu. Concatenated data files are text files, just
like profilometer data files, but the program can distinguish between which
type is being loaded. When a concatenated data file is being loaded, the
menu shown in Figure 14 appears and inquires which features you would like
to plot. The possible features include: the left cursor height (Hl), the right
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Figure 13: Once several data points have been added to the concatenated menu,
it will look more like this.

cursor height (Hr), the difference in height between the cursors (Hdiff), all of
the data points between the cursors (H), or any combination of the average
height (Havg), the deviation (Hdev), and the surface roughness (Ra). One
the desired options are selected, you simply need to click on plot data to
create a plot in the program window.

Figure 15 shows an example of a concatenated data set plotted using the
average height, deviation (shown as blue error bars), and surface roughness
(shown as red error bars). The resulting plot can then be saved as an image
using the Save Plot function under File in the drop-down menu.
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Figure 14: When loading a concatenated data set, this menu allows you to select
what to plot. You can plot either the left cursor height (Hl), the right cursor
height (Hr), the difference in height between the cursors (Hdiff), all of the data
points between the cursors (H), or any combination of the average height (Havg),
the deviation (Hdev), and the surface roughness (Ra).

9 Conclusion

I hope that this program proves to be useful in your research. This is still
a work in progress, so don’t be surprised if you find any strange behavior or
errors from time to time. Feel free to alter the code for your own purposes,
or contact me with any problems that you may discovered at marknham-
blin@gmail.com.
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Figure 15: Concatenated data plotted in the program window. The data shown
here represents the average height for several features with blue error bars indi-
cating deviation and red error bars indicating surface roughness.
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